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Extensis Mask Pro là công cụ tốt nhất để tạo vùng lựa chọn và mặt nạ cho Adobe Photoshop. 

Phần hướng dẫn nhanh này sẽ giúp bạn làm quen với khả năng kết hợp màu sắc tiên tiến và 

công nghệ loại vùng “ô nhiễm”. Phần này cũng giới thiệu cho bạn những tính năng mới đã được 

cải tiến, nó cho phép bạn quyền kiểm soát hoàn toàn những đường viền trong suốt của đối 

tượng và màu nền của nó. Và bạn sẽ học những kỹ năng cơ bản của việc tạo vùng lựa chọn và 

mặt nạ một cách chính xác nhất.  

 

Mặt nạ là gì? 

Tạo mặt nạ là một quá trình lựa chọn và sau đó xoá đi những phần của hình ảnh. Thông thường 

bạn chọn một phần của tấm hình bạn muốn giữ và xoá đi những phần bạn muốn bỏ. Và sau đó 

bạn có thể ghép nó với hình gì bạn muốn. Ví dụ bạn có thể đặt một chiếc xe lên trên đỉnh núi 

hoặc một người trong bộ áo tắm bikini vào vùng băng giá nhất của bắc cực. 

 

Điều làm cho Mask Pro rất hiệu quả là khả năng sử dụng bất cứ công cụ nào cho bất cứ công 

việc tách hình nào. Tạo vùng lựa chọn cho một con chim xanh trong cánh rừng màu xanh đòi hỏi 

những kỹ năng khác với việc tách một chiếc xe màu xanh ra khỏi nền là bãi cát trên sa mạc. 

Mask Pro có công cụ mà bạn cần và cho hình ảnh mà bạn muốn tách. 

 

Phần mềm Mask Pro khi được cài đặt sẽ hoạt động như một plugin của Photoshop. Do vậy khi 

bạn muốn khởi động chương trình thì hãy khởi động Photoshop trước và sau đó vào Filter > 

Extensis 
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Những cái mới của Mask Pro 3 

 

Color Decontamination 

- Tăng khả năng tạo vùng lựa chọn ở những đường viền bán trong suốt như là tóc và những vật 

trong suốt như thuỷ tinh 

- Tách đối tượng ra khỏi màu nền từ những Pixel màu, loại bỏ hiệu ứng đường viền bao quanh 

còn sót lại sau khi tạo vùng lựa chọn. 

Công cụ Highlight  

- Cho phép bạn định nghĩa vùng Keep (giữ) và vùng Drop (bỏ), với những pixel được giữ hoặc 

bỏ phụ thuộc vào những màu được highligh trong vùng đó. 

- Có thể loại bỏ yêu cầu để để kích hoạt hoặc bỏ kích hoạt màu sắc khi bạn tạo vùng lựa chọn 

quanh tấm hình. 

Công cụ Chisel  

- Cung cấp khả năng điều chỉnh tính chính xác của đườn viền bằng cách bỏ đi hoặc tái lập 

những pixel từ bất cứ vùng nào của đường viền. 

Công cụ Blur  

- Làm mềm đường viền của mặt nạ để kết hợp nó đẹp hơn với những hình nền khác. 

 
Tuỳ biến công cụ 

 

 

- Palette mới này tập hợp tất cả những tuỳ biến của từng công cụ tại một vị trí trung tâm để có 

những điều chỉnh công cụ hiệu quả hơn và tổ chức môi trường làm việc tốt hơn. 
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Hỗ trợ con lăn của chuột 
- Mask Pro đã được nâng cấp để lợi dụng sự cải tiến của hệ điều Mac OS X trong Photoshop 

7.0, bao gồm hỗ trợ phím tắt với con lăn của chuột. 

 
Cải tiến cho Keep và Drop Palette 

 

 

- Vùng hình nhỏ hiển thị từng vùng của tấm hình mà bạn lấy từ hình mẫu. 

- Chọn một dải màu hoặc nhiều màu, một pixel đơn lẻ hoặc lấy màu một cách chính xác bằng 

hộp thoại Color Picker 

 

Tăng khả năng kết hợp 

- Composite View hiển thịn layer nằm dưới khi bạn tạo vùng lựa chọn (chỉ áp dụng với hình nhiều 

layer) 

- Orginal View cho phép bạn so sánh hình trước và sau khi được tách. 

 

 

Sử dụng công cụ Chisel để loại bỏ hiệu ứng đường viền bao quanh 
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Bắt đầu 

Một vài tấm hình khi tạo vùng lựa chọn chỉ cần sử dụng một vài công cụ của Mask Pro cũng có 

thể tạo được một vùng lựa chọn đẹp, nhưng cũng có những hình thì đòi hỏi bạn phải dùng hầu 

hết những công cụ trong hộp công cụ. Do vậy hiểu hết những công cụ của Mask Pro là việc thiết 

yếu để tạo một vùng lựa chọn hiệu quả và có kết quả hoàn hảo nhất. 

Tạo mặt nà và vùng lựa chọn. 
Tạo mặt nạ có nghĩa là bạn tô lên hết tất cả các Pixel của một tấm hình để biến nó thành vùng 

trong suốt, ngoại trừ vùng được chọn là vùng bạn muốn giữ. Bởi vì khi tách hình là bạn muốn 

dùng hình được tách để ghép nó với một hình khác hoặc đặt trên một nền khác. Ví dụ bạn có thể 

tạo mặt nạ cho toàn bộ tấm hình sau ngoại trừ những quả bong bóng và cô gái, sau đó bạn sẽ 

ghép nó với hình công viên. 

  

 

Tạo vùng lựa chọn cũng hoạt động theo nguyên lý trên, ngoại trừ những pixel thực sự không 

được thay đổi. Ví dụ bạn có thể chọn cô gái và những quả bong bóng, sau đó áp dụng bộ lọc 

Photoshop vào những vùng đó nhưng giữ nguyên hình nền mà không thay đổi gì. 

Để tạo mạt nạ và loại bỏ hình nền. 
- Mở một tấm hình trong Photoshop và chọn Filter > Extensis > Mask Pro 3 

 

Để tạo một vùng lựa chọn chính xác nhưng giữ nguyên hình nền 

- Mở một tấm hình trong Photoshop và chọn Select > Extensis > Mask Pro 3 Select 
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Mask Views  

Đôi khi nó rất khó khăn để nhìn thấy những hiệu ứng hoặc thay đổi trong khi tạo một vùng mạt nạ 

phức tạp. Tuỳ biến đa phương diện của Mask Pro tạo cho nó dễ dàng hơn dù cho tấm hình đó có 

phức tạp đến đâu đi chăng nữa. 

Original View - Chế độ này thể hiện hình gốc để so sánh với những gì bạn thay đổi. 

Solid View - Thể hiện những vùng được loại bỏ dưới dạng một màu đặc. 

Single Layer View - thể hiện những vùng bị loại bỏ dưới dạng lưới. 

Quick Mask View (chỉ có trong Mask Pro Select) - Thể hiện những vùng bị loại bỏ như là một 

mặt nạ màu ngọc bích. Vùng được chọn sẽ trở thành vùng lựa chọn khi mặt nạ được lưu lại. 

Mask View - Thể hiện kênh alpha của mặt nạ - vùng loại bỏ 100% là màu đen và vùng giữ 

100% là màu trắng. 

Cleanup View - Thể hiện vùng được giữ 100% là màu trắng và vùng được loại bỏ 100% là 

màu đen và vùng giao nhau là màu xám. Sử dụng chế độ này để tìm những lỗ nhỏ trong mặt nạ 

của bạn. 

Composite View - Thể hiện những layer nằm dưới xuyên qua vùng được tẩy - chỉ có trong khi 

bạn tạo vùng lựa chọn của hình gồm nhiều layer. 

Thanh trượt Highlight Opacity Điều khiển độ rõ mờ của vùng Keep và 

Drop Highlight, có giá trị từ 0% (hoàn toàn trong suốt) đến 100% (màu đặc). Keep và Drop 

Highligher vẫn có tác dụng khi bạn điều khiển thanh trượt. 

Chế độ xem Channel (RGB, CMYK, LAB) 
Những chế độ xem riêng biệt hoặc kết hợp được thể hiện ở những nút ở góc trên bên phải của 

cửa sổ Mask Pro. Hình hiển thị thay đổi phụ thuộc vào loại hình đang được mở. 

 

Công cụ của Mask Pro và các Palette 

Hầu hết những lệnh bạn sẽ dùng trong Mask Pro 3 được sắp xếp trong hộp công cụ, Keep và 

Drop Color Palette, Navigator và Tool Option Palette. Phím tắt được hiển thị ở dưới hai dấu 

ngoặc đơn. Xem thêm phần Mask Pro 3 Quick Reference Card để học toàn bộ phím tắt của 

chương trình. 
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Tạo một vùng mặt nạ 

Mask Pro khác biệt về cơ bản với những ứng dụng hoặc Plug-in về tạo mặt nạ hiện có. Mask Pro 

là một ứng dụng trực giác sử dụng công nghệ kết hợp màu sắc. Bạn chỉ đơn giản chọn màu mà 

bạn muốn giữ hoặc bỏ và sau đó bắt đầu tạo mặt nạ. 

 

Chọn màu giữ hoặc bỏ 

Để nhanh chóng định nghĩa màu bạn muốn giữ và bỏ, sử dụng Keep và Drop Eyedropper 

và/hoặc Keep và Drop Highlighter. 

 

Keep và Drop Eyedropper và Color palette  

Chấm nhỏ màu xanh xác định vùng màu sẽ được giữ và không bị tẩy đi bằng công cụ Magic 

Brush và Magic Wand. Chấm nhỏ màu đỏ Drop Eyedropper xác định những màu sẽ không được 

giữ và bị tảy đi bởi những công cụ trên. Khi bạn lựa chọn những vùng của một tấm hình với công 

cụ Eyedropper, những vùng đó sẽ được ghi lại trong Keep và Drop Palette. 
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A: Hình mẫu 

B: Tắt tập hợp màu 

C: Mở tập hợp màu 

D: Màu không xác định 
  

  

Để xác định màu Keep và Drop 

- Chọn một công cụ Eyedropper và nhấp chuột vào tấm hình. 

- Shift -Click để thêm màu khác vào tập hợp màu của bạn (hoặc đánh dấu vào hộp kiểm Tool 

Option, xem trang 12 để biết thêm chi tiết) 

- Kéo xung quanh tấm hình để xác định những màu trung tính. 

  

Nhấp đúp vào một màu trong Palette để xác định một giá trị màu cụ thể sử dụng cho công 

cụ chọn màu. 

- Những màu bạn muốn xoá hoặc giữ trong một vùng của một tấm hình có thể rất khác biệt với 

những màu ở vùng khác. Thay vì thay đổi màu mẫu khi bạn làm việc xung quanh một tấm hình, 

bạn có thể tạo một tập hợp màu cho những vùng khác nhau của tấm hình. 

- Tập hợp màu có thể được tắt hoặc mở dễ dàng bằng cách nhấp chuột vào LED - ở bên trái của 

mỗi tập hợp. 

Để tạo một tập hợp màu 

- Nhấp chuột vào nút New Set hoặc kéo một mãu màu bất kỳ vào nút New Set. 

Để tăt hoặc bật một mãu màu hoặc một tập hợp 

- Nhấp chuột vào bên trái của mãu mầu hoặc tập hợp màu. 
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Để có kết quả tốt nhất hãy cố gắng làm việc với không quá 3 hoặc 4 màu Keep hoặc Drop 

cùng một lúc 

Tạo một vùng lựa chọn hoàn hảo 

Ai cũng biết tách tóc ra khỏi nền là công đoạn khó nhất trong việc tách đối tượng, đây sẽ là một 

ví dụ rất tốt để chứng minh hai tính nắng Keep và Drop tạo ra sự khác biệt như thế nào. Để vẽ 

mặt nạ cho hình này bạn nên 

1. Phóng to phần đầu của cô gái 

2. Sử dụng Keep Eyedropper để chọn 3 màu của màu Keep từ phần tóc của cô gái - một màu tối, 

một màu sáng và một màu trung tính (nhấn vào màu thứ nhất, giữ phím Shift và nhấn vào màu 

thứ 2 và thứ 3 

3. Kéo Drop Eyedropper qua hình nền xung quanh phần trên đầu của cô gái để xác định màu 

Drop. 

  

 

Bước tiếp theo của bạn có thể là tạo vùng mặt nạ với công cụ Magic Brush và kết hợp với chế độ 

Erase/Restore. Để biết thêm về phần tạo mặt nạ sau khi tạo vùng lựa chọn Keep và Drop, xem 

thêm trang 12.  
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Keep và Drop Highlighter 
Thay vì xác định màu nào được giữ hoặc xoá ở toàn bộ tấm hình, công cụ Highlihgter xác định 

vùng Keep và Drop. Vùng được bao phủ bởi Highlighter sẽ được giữ 100% hoặc bỏ (phụ thuộc 

vào công cụ), và Mask Pro sử dụng màu, vùng với vùng, để xác định vùng nào giữ và vùng nào 

bỏ. Mask Pro tự động thêm hoặc bớt màu Keep và Drop khi bạn làm việc với vùng được 

highlight. Nó sẽ là một phương pháp tuyệt diệu để tạo vùng mặt nạ cho hình với những vùng 

màu tương đồng trong vùng Keep và Drop. 

Để tạo vùng Keep và Drop 

- Kéo Highlighter xung quanh vùng bạn muốn giữ hoặc bỏ, gần nhưng không được qua đường 

biên giữa vùng muốn giữ hoặc bỏ. 

- Để vẽ một đường thẳng bằng công cụ Highlighter, nhấp chuột một lần vào điểm bắt đầu, sau đó 

giữ phím Shift và nhấp vào điểm bạn muốn đường thẳng kết thúc. 

 

 

Công cụ Drop Highlight xác định màu để xoá xung quanh bên ngoài của quả bóng ở trên, trong 

khi đó màu xanh của Keep Highlihgt nói cho Mask Pro biết nó phải giữ tất cả những màu nào 

nằm trong quả bóng ở dưới. 

Tô màu vào vùng đóng với Highlighter 
- Giữ phím Ctrl hoặc Command (Mac) và nhấp vào một vùng đóng bằng công cụ Highlighter - 

Con trỏ sẽ biến thành hình chiếc xô . Nó sẽ bảo đảm rằng tất cả vùng đó sẽ được giữ hoặc 

loại bỏ. 

 

Bạn phải sử dụng cùng một công cụ để tô cho vùng đóng - Drop Highlighter trong vùng cần 

loại bỏ, Keep Highlighter với vùng cần giữ. 
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Loại bỏ Highlight trên một tấm hình: 
- Giữ phím Alt trong khi kéo (con trỏ biến thành cụ tẩy) hoặc; 

- Giữ phím Alt và nhấp đúp công cụ Keep hoặc Drop Highlighter trong hộp công cụ để loại bỏ 

hoàn toàn vùng Highlight ngay lập tức. 

 

Highlight ở đâu? 

Bông hoa hồng ở trên nền là một tán lá là một ví dụ rất tốt cho công cụ Highlighter. 

1. Sử dụng Keep Highlighter màu xanh lá cây để tô theo đường viền của bông hoa hồng gần 

nhất với màu xanh lá, cố gắng đừng vượt quá ra ngoài đường viền. 

2. Sử dụng công cụ Drop Highlighter màu đỏ để tô theo đường viền ở vùng màu xanh lá cây, cố 

gắng đừng tô lấn vào bông hoa. 

3. Ctrl-Click vào vùng màu xanh Keep Highlighter với công cụ fill ở phía bên phải của màu xanh 

để tô toàn bộ bông hoa với công cụ Keep Highlight. 

4. Ctrl-Click với công cụ màu đỏ Drop Highlighter vào bên phải của vùng highlight màu đỏ để tô 

toàn bộ tán lá còn lại với công cụ Drop Highlight. 

 
  

Tạo mặt nạ cho hình nền 

Một khi màu Keep và Drop đã được xác định và chế độ đúng của mặt nạ đựơc chọn, bắt đầu tạo 

vùng mặt nạ cho hình nền. Công cụ Magic của Mask Pro hiểu màu Keep và Drop và/hoặc những 

vùng đã được xác định. Một vùng mặt nạ sẽ được thành lập dựa trên thông tin này. 
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Bạn nên chú ý đến những thay đổi ở trên thanh tuỳ biến công cụ khi mỗi công cụ được 

chọn.  

Magic Brush  

Công cụ Magic Brush tạo ra vùng mặt nạ một cách rất thông minh xung quanh hình nền của tấm 

hình bằng cách đọc những màu Keep và Drop trên Palette. Đây là một trong những công cụ 

mạnh nhất trong hộp công cụ bởi vì nó cho phép bạn có toàn quyền kiểm soát đường viền của 

vùng mặt nạ. Sử dụng công cụng Magic Brush khi nào hình nền trước và nền sau có sự khác 

biệt đủ lớn để chọn màu và vùng Drop hoặc Keep. 

 

Sử dụng công cụ Magic Brush: 
- Chọn công cụ Magic Brush trong hộp công cụ và kéo trong tấm hình; hoặc 

- Nhấp đúp vào công cụ Magic Brush trong hộp công cụ để áp dụng hiệu ứng của nó trên toàn bộ 

tấm hình. Ở tấm hình trên, bạn có thể bắt đầu tô vùng bên trái sau khi đã lấy mẫu cho màu và 

vùng Keep và Drop. Đánh dấu vào hộp thoại "Use color decontamination" sẽ giúp bạn giữ màu 

tóc trong khi xoá hình nền. Nếu có quá nhiều hình nền bị giữ lại, bạn có thể giảm bớt Threshold 

hoặc chọn một màu Drop khác. 
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Bạn có thể undo từng vùng riêng lẻ của bất cứ nét vẽ nào bằng cách nhấn phím Delete 

hoặc Ctrl - Z. Undo toàn bộ nét vẽ bằng cách nhấn Shift-Delete hoặc Shift-Ctrl-Z. 

Trong tấm hình bông hoa hồng, bạn có thể bắt đầu vẽ dọc theo đường biên giữa vùng Keep và 

Drop, sau đó chuyển sang Bucket để tẩy những phần hình nền còn sót lại hoặc đơn giản nhấp 

đúp công cụ để áp dụng cho cả tấm hình. 

Về chế độ Masking  

Hầu hết những côgn cụ của Mask Pro hoặt động đều là trông chế độ Erase (màu xanh) hoặc chế 

độ Restore (màu đỏ), với chế độ hiện hành được thể hiện ở vùng nhỏ trong hộp công cụ. Ở chế 

độ Erase, công cụ sẽ tẩy những pixel thành trong suốt - là việc mà bạn muốn. Trong chế độ 

Restore, những pixel nào đã bị xoá sẽ được hiện lại, và trả lại trạng thái ban đầu cho hình. Nó 

hoạt động gần giống như công cụ History Brush trong Photoshop.  

Nhấp chuột vào phần này của hộp công cụ sẽ thay đổi chế độ từ Erase sang Restore hoặc sang 

chế độ kết hợp Erase/Restore (nửa đỏ, nửa xanh). Tuỳ biến cuối cùng này chỉ có trong công cụ 

Magic Brush và Magic Bucket. Khi chế độ Erase/Restore được chọn, Mask Pro quyết định một 

cách thông minh pixel nào sẽ đựơc Erase hoặc Restore, dựa trên những màu hoặc vùng Drop và 

Keep. 

Magic Wand  

Sử dụng công cụ Magic Wand cũng tương tự như việc vẽ qua toàn bộ tấm hình với công cụ 

Magic Brush. Nó thích hợp nhất với những hình có hình nền giản đơn và có độ tương phản cao 

giữa màu Keep và Drop. 

Sử dụng công cụ Magic Wand 

- Sử dụng công cụ Magic Wand trong hộp công cụ và nhấp chuột vào hình. 

Nếu càng ít màu hoặc vùng Drop và Keep được chọn thì công cụ Magic Wand hoạt động 

càng hiệu quả. 
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Magic Pen  

Sử dụng công cụ Magic Pen ở những vùng có giá trị màu Drop và Keep tương đồng với nhau và 

có một đường biên rõ ràng giữa nền trước và nền sau. Công cụ Magic Pen tự động xác định 

đường biên của hình và tạo ra một đường path và dính vào viền khi bạn kéo. 

 

Sử dụng công cụ Magic Pen  

- Nhấp chuột để xác định điểm đầu tiên và kéo công cụ Pen để đi theo đường biên. 

- Nếu đường path trượt ra khỏi đường viền, kéo ngược lại, thả chuột để tạo một điểm neo và tiếp 

tục kéo. 

Vẽ tiếp Magic Path 

- Nhấp chuột vào điểm được thả sau cùng để tiếp tục kéo. 

Đóng Magic Path 

- Kéo công cụ Magic Pen cho đến khi nó vượt qua điểm ban đầu và một hình tròn xuất hiện gần 

con trỏ và click chuột hoặc; 

- Giữ phím Ctrl và nhấp vào hình. 

Một khi path được đóng, con trỏ sẽ trở thành Gavel (cái búa). Nhấp công cụ Gravel vào bên 

trong hoặc bên ngoài đường Path để xoá hoặc tái tạo lại những pixel ở bên phía đó. 
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Công cụ tiêu chuẩn 

Hầu hết tất cả hình ảnh đều có những vùng cần phải tạo vùng mặt nạ hoàn toàn là những vùng 

không yêu cầu sự kết hợp tinh tế của màu sắc của công cụ Magic. Trong trường hợp này, Mask 

Pro có một loạt những công cụ tiêu chuẩn cho phép bạn nhanh chóng tạo vùng mặt nạ cho 

những phần của tấm hình đó. Những công cụ đó là Brush, Airbrush và Pen. Những công cụ này 

cũng có thể được dùng để chỉnh sửa những vùng mặt nạ gần hoàn thiện. 

Brush  

Brush chỉ đơn giản tẩy hoặc tái tạo lại tất cả những Pixel nằm dưới nét vẽ. Bạn có thể sử dụng 

nó để vẽ một cách nhanh chóng một vùng lớn của hình nền. 

Sử dụng Brush 

- Chọn biểu tượng của nó trong hộp công cụ và vẽ lên tấm hình. 

Air Brush  

Công cụ Airbrush hoạt động giống như công cụ Airbrush của Photoshop. Nó cho phép bạn kiểm 

soát độ đậm nhạt của nét vẽ và bạn có thể điều chỉnh được độ trong suốt của đường viền của 

mặt nạ. Nó có thể được sử dụng trong chế độ Erase hoặc Restore. 
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Nét vẽ với (a) nhạt (b) vừa và (c) là đậm 

 Sử dụng Airbrush: 

- Chọn biểu tượng của nó trong hộp công cụ. 

- Nếu cần thiết, thiết lập độ đậm của nét vẽ trong pallete tuỳ biến công cụ 

- Vẽ lên tấm hình. 

 

Pen  

Công cụ Pen tạo một path từ những đường thẳng và đường cong, đây là một công cụ hữu dụng 

nhất trong việc tạo những vùng có đường viền mịn và nét nếu tấm hình bạn muốn tách không có 

sự khác biệt lớn giữa đối tượng và hình nền. 

 

Sử dụng công cụ Pen 

- Chọn biểu tượng của nó trong hộp công cụ và vẽ một đường Path giống như khi bạn dùng Pen 

ở trong Photoshop hoặc Illustrator. 

- Một khi path được đóng, con trỏ sẽ chuyển thành Gavel. Nhấp Gavel vào trong hay ra bên 

ngoài của đường path vừa tạo sẽ giúp bạn xoá hoặc tái lập những Pixel nằm trong hay nằm 

ngoài đường Path. 

 

Chỉnh sửa mạt nạ 

Cho dù công cụ đó có hoàn hảo thế nào đi chăng nữa thì tất cả mặt nạ đều cẩn phải chính sửa. 

Mask Pro cung cấp một bộ những công cụ mà cho phép bạn chỉnh sửa mask một cách dễ dàng.  

 

Bucket  

Công cụ Bucket xoá hoặc tái lập tất cả những Pixel kế tiếp nhau từ vùng được nhấp chuột. Một 

khi bạn đã tạo được một đường bao quanh đối tượng của mình, thì bạn có thể dùng công cụ 

Bucket để xoá toàn bộ phần muốn bỏ bằng một lần nhấp chuột. 

 

Sử dụng công cụ Bucket 
- Chọn biểu tượng của nó trong hộp công cụ và nhấp vào hình ảnh. 

 

Nếu bạn chẳng may tô cả tấm hình bởi vì một chỗ "thủng" nào đó trong mạt nạ của bạn, 

nhấn phím Delete để Undo lệnh fill vừa rồi, sử dụng Brush để sửa lại đường viền và thử fill lại lần 

nữa. 
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Chisel  

Công cụ Chisel được sử dụng để cắt tỉa hoặc tái thiết lập lại những Pixel từ đường viền của mặt 

nạ. Sử dụng công cụ Pixle khi bạn muốn tái lập thật chính xác những Pixel cho một tấm hình mà 

có mặt nạ quá gần nhau, hoặc lằm chặt chẽ hơn đường viền của mặt nạ nếu nó quá lỏng hoặc 

nó bao gồm một ít của hình nền. 

 

Sử dụng công cụ Chisel 
- Chọn biểu tượng của nó trong hộp công cụ và kéo dọc theo đường biên của mạt nạ, 

Mỗi lần nhấp hoặc kéo nét vẽ sẽ dãn mặt nạ ra với số lượng được xác định từ trước trong 

palette tuỳ biến công cụ. Hiệu ứng sẽ không tăng nếu bạn tô nhiều lần lên cùng một phần với 

cùng một nét vẽ. 

 

 
 
Sử dụng công cụ Chisel để loại bỏ đường viền của mặt nạ 

 

BLUR  

Công cụ blur hoà trộn hoặc tạo ra vùng giao nhau giữa đường viền sắc nét của mặt nạ và hình 

nền của nó bằng cách trung hoà những Pixel nằm giữa hai vùng. 

 

Sử dụng công cụ Blur: 

- Chọn biểu tượng của nó trong hộp công cụ và kéo dọc theo đường bao quanh của mặt nạ. 
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Sử dụng công cụ Blur, cạnh sắc của mặt nạ đang tạo sẽ được trộn dễ dàng hơn vào hình nền. 

Chế độ Restore không có ảnh hưởng đến công cụ Blur - Nếu chế độ mask được chọn thì 

khi được sử dụng công cụ Blur sẽ làm mờ dần đường viền. Để Undo blur, giữ phím Delete xuống 

hoặc nhấn Ctrl-Z. 

Magic Bucket  

Công cụ Magic Bucket được sử dụng để xoá những mẩu vụn của hình nền bị xót lại trong quá 

trình tạo vùng mặt nạ, hoặc dùng để tái lập những lỗ hổng ở nền trước đã không may bị tạo ra 

trước đây. Trong chế độ Erase/Restore, nó sẽ làm đồng thời cùng một lúc. 

 

 

Loại bỏ mẩu vụn với công cụ Magic Bucket 

Sử dụng công cụ Magic Bucket: 

- Chuyển sang chế độ Cleanup View để xem những lỗ hổng và mẩu vụn rõ ràng hơn. 

- Chọn công cụ Magic Bucket và kéo nó dọc theo những vùng bị ảnh hưởng bởi mặt nạ. 

- Nhấp đúp vào biểu tượng Magic Bucket trong hộp công cụ để áp dụng hiệu ứng cua nó lên toàn 

bộ tấm hình.  
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Thoát khỏi Mask Pro 

Một khi bạn đã hài lòng với kết quả cuối cùng của mặt nạ, lưu lại kết quả và trở về với 

Photoshop: 

- Chọn File > Save/Apply, hoặc; 

- Nhấn Ctrl-W hoặc Ctrl-Q 

Tùy biến công cụ 

Giá trị mặc định của những công cụ trong Mask Pro đều có thể sử dụng cho hầu hết các tấm 

hình, nhưng mỗi một lựa chọn có thể được điều chỉnh để phù hợp hơn với một vùng cụ thể. 

Palette tuỳ biến công cụ giữ những thiết lập của công cụ tại một vị trí trung tâm, và chỉ thể hiện 

những tuỳ biến của công cụ hiện hành. 

 

Brush size (kích thước brush): Được thể hiện ở vòng tròn bên trong của con trỏ (Highlighter, 

Brush, Airbrush, Magic Brush, Chisel và Blur) 

 

 

Blur Edge - Được xác định bằng vòng tròn bên ngoài của con trỏ, nó thể hiện độ lớn của vùng 

giao nhau  trên đường viền của mặt nạ (Brush, Magic Brush, Airbrush, Chisel, Blur) 

Threshold: Xác định độ tương đồng về màu của nét vẽ so sánh với những màu mãu Keep và 
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Drop. Thiết lập gần về "Less" thì càng ít phần của hình được giữ lại. Thiết lập gần về "More" thì 

nhiều phần của tấm hình được giữ lại (Magic Brush, Magic Wand). 

Transition: xác định vùng giao nhau tại đường viền của mặt nạ. Đường viền càng mềm mại thì 

kết quả càng đẹp với những hình bán trong suốt như là khói, tóc và thuỷ tinh. Những đường viền 

được định dạng rõ ràng hơn thì bạn nên thiết lập Transition lớn hơn (Magic Brush, Magic Wand). 

Color decontamination: Loại bỏ hiệu ứng đường viền của hình nền từ tấm hình. Nó yêu cầu ít 

nhất một màu Keep hoặc Drop phải được chọn, bởi vì nó sử dụng thông tin này để tách những 

màu Drop từ đường viền và thay nó với màu Keep (Magic Brush, Magic Wand). 

 

Magnetic Area: Là vùng nằm trong vùng công cụ Magic Pen tìm đường viền, được hiển thị là 

một vòng tròn bao quanh công cụ Magic Pen (Magic Pen). 

 

 

Edge Attraction: Xác định độ mạnh yếu mà đường Path sẽ dính vào đường viền khi công cụ 

Magic Pen vẽ trên nó (Magic Pen). 

 

Mask Edge: Làm mềm kết quả của đường viền sau khi vùng lựa chọn đã được "đập đi" bằng 

công cụ Gavel (Pen, Magic Pen). 

Fill Area: Được xác định là một hình vuông bao quanh con trỏ, đây là vùng nằm trong vùng mà 

công cụ Magic Bucket sẽ tìm để tô vào lỗ hổng hoạc xoá đi những mảu vụn (Magic Bucket).  

 
 

Intensity: Độ đậm nhạt của hiệu ứng Airbrush. Nếu được thiết lập càng đậm thì độ trong suốt 

của những pixel dưới con trỏ sẽ thay đổi theo. Khi mức Intensity được đặt lên tối đa, thì công cụ 

Airbrush có công dụng như Brush Airbrush). 

Chisel Amount: Số lượng những pixel sẽ bị "cạo đi" khỏi mặt nạ hoặc được tái lập (Chisel). 

 

Blur amoung: Số lượng blur sẽ được áp dụng lên đường viền của mặt nạ (Blur). 
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Add new color continuously - Hộp kiểm này sẽ có trong mỗi một công cụ Keep và Drop 

Eyedropper, nó xác định hành vi mặc định của những lần click chuột vào hình. Nếu hộp kiểm này 

được đánh dấu, mỗi lần nhấp chuột sẽ chỉ thị một màu mới đến palette tương ứng. Nếu hộp 

kiểm không được đánh dấu, nhấp chuột vào hình sẽ tác xác định những màu đang được chọn, 

bao gồm màu thứ nhất trong Palette (ví dụ xác định màu không xác định). 

 

 

- Shift-Click vào hình sẽ thêm một màu mới. 

- Alt-click vào hình sẽ tái xác định màu đang được chọn. 

- Ctrl-Click vào hình sẽ thêm màu mới và tập hơp màu mới. 

Nguồn: Mask Pro 3 Quick start guide 
 
© Bá tước Monte Cristo - www.vietphotoshop.com 
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